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VIMAR SpA with head offices in Marostica (VI), Viale Vicenza n. 14, sole proprietor of the software denominated 

"Touchscreen Configurator for Well-contact Plus", with the present contract concedes a licence for the use of the 

said software.

VIMAR SpA declines all liability for any damages arising from improper use of the software contained in the CD, 

in particular for direct or indirect injury to persons or animals and damage to property as regards financial losses 

resulting from the use of the software.

VIMAR SpA reserves the right to modify and improve the said software at any time without advance notification. 

Any modification, translation, adaptation and creation of applications based on the “Touchscreen Configurator for 

Well-contact Plus” software without the express written authorisation of VIMAR SpA is prohibited.

 

Vimar user license contract

IMPORTANT: Before using the software, always make sure that the touchscreens have the 
latest firmware installed. Take care to check, in the Product Software section of the website 
www.vimar.com, that there is the latest firmware which can be downloaded and installed on 
the touchscreens. 

 



Software Configuratore touch screen per Well-contact Plus

Section 1: Colour touchscreen 21848.1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                                   	 1

Section 2: 3-module colour touchscreen  21849.1  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .                                           	 59

Contents



1

Software Configuratore touch screen per Well-contact Plus

Section 1
Colour touchscreen 21848.1



2

Software Configuratore touch screen per Well-contact Plus



3

Software Configuratore touch screen per Well-contact Plus

Table of Contents

1. Minimum hardware and software requirements………………………………………………………………    4

2. Installing the program… …………………………………………………………………………………………    4
2.1 Configuring systems for adding the touchscreen……………………………………………………………    4

3. Functional description of the Touchscreen software…………………………………………………………    5
3.1 Functions… ……………………………………………………………………………………………………    5
3.2 General notes……………………………………………………………………………………………………    5

3.2.1 Non-permitted characters… ……………………………………………………………………………… 5

4. Functions………………………………………………………………………………………………………………  6

5. Exporting system configuration files from ETS3 and importing in the software……………………………  7
5.1 The "System structure" file ………………………………………………………………………………………  8
5.2 The "Devices" file ………………………………………………………………………………………………  10
5.3 The "Device configuration" file … ……………………………………………………………………………  12
5.4 The "ESF" file … ………………………………………………………………………………………………  14
5.5 Exporting system configuration files from ETS4 and importing in the software……………………………… 16
5.6 Configuring the touchscreen and updating the software and firmware ……………………………………  18

6. Touchscreen configuration parameters…………………………………………………………………………  20
6.1 Adding Environments … ………………………………………………………………………………………… 23

6.1.1 Selecting Graphics ………………………………………………………………………………………  24
6.1.2 Adding Relays… …………………………………………………………………………………………… 26
6.1.3 Adding Roller Shutters and Blinds………………………………………………………………………… 29
6.1.4 Adding Dimmers… ………………………………………………………………………………………… 32
6.1.5 Adding HVAC… …………………………………………………………………………………………… 39
6.1.6 Adding a Single communication object…………………………………………………………………    51

6.2 Selecting the default page… …………………………………………………………………………………  56

7. Help		 ………………………………………………………………………………………………………………  57



4

Software Configuratore touch screen per Well-contact Plus

Requirements - Installation - Functions

4

1. Minimum hardware and software requirements

Software:

• Microsoft Windows 98/2000/XP/Vista/7/8/10/11 Operating System.
• Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10 Operating System.

Hardware:

• 100 MB of free space on hard disk
• Mouse
• CD-ROM
• Serial Port

2. Installing the program

The user will be guided through the installation of the program by a special wizard; the required information for 
this is all given in the manual for the software and for the PC.

2.1 Configuring systems for adding the touchscreen
This window lets you define the devices and systems that have to be paired with the plant to be managed.  
To activate this window, there should be no active modules: all the modules must then be closed before 
configuring the plant's systems.

You can access this function from the menu Systems ► Configuration.



5

Software Configuratore touch screen per Well-contact Plus

Requirements - Installation - Functions

3. Description of Touchscreen configurator software for Well-contact Plus

3.1 Functions
The Touchscreen configurator software for Well-contact Plus can be used to:  
1.	configure touchscreens, adding different environments, each with the required elements (automation 

control, scenarios, 2bit objects, KNX weather stations, etc.).
2.	display and modify the touchscreen layout, adding and deleting devices or changing the position of the 

existing ones; 
3.	send configurations to the touchscreens connected to the PC; 
4.	update software on touchscreen devices.  

3.2 General notes

3.2.1 Non-permitted characters

The following characters may not be inserted in the text fields:

&

<

>

Each part of the application will now be analyzed, and its operation explained. 

The descriptions used in the touchscreens should be without accented characters.
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4. Functions.

The following is a detailed analysis of the application's functions.

Legend of function buttons common to the entire application:

Navigation buttons:

 	 Go to first item in folder

 	 Go to previous item from the one displayed

 	 Go to next item from the one displayed

 	 Go to last item in folder

Function buttons:

 	 Lets you modify the data displayed

 	 Confirms all the changes made (adding a new item or modifying an existing item)

 	 Cancels the last changes or new addition and restores the previous state

Touchscreen management buttons:

 	 Lets you add a new item in the folder

 	 Deletes the item displayed

 	 Sends the data set on the software to the touchscreen

 	 Updates the touchscreen software

The following is a detailed description of the application windows and the available operations.

Functions
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5. Exporting system configuration files from ETS3 and importing in the software.

The procedure for importing system data uses four files to describe the system. These files must be created in 
advance using the ETS3 export procedure and are the following:

•	 System structure file (XML type file)
•	 Devices file (XML type file)
•	 Device configuration file (XML type file)
•	 ESF file (ESF type file)

These four files contain information on system topology, installed devices, the group addresses assigned to the 
various devices and the list of all defined addresses. The following sections describe the four files and how to 
create them via ETS3.

IT IS IN ANY CASE MANDATORY TO ADD THE TOUCHSCREENS TO THE ETS PROJECT TOO AND ADD 
THEIR "DATE", "TIME" and "DATE-TIME" OBJECTS TO THREE GROUPS TO BE CREATED WITH THE 
SAME NAME AS THE OBJECTS OF THE TOUCHSCREEN, THEN USING THE PHYSICAL ADDRESSES 
OF THE TOUCHSCREENS ALSO IN THE CONFIGURATION SOFTWARE (in the "address", "time", "date", 
"date and time" fields).

CAUTION: In ETS, the sequence of the columns must always be the same (for the Buildings window and for the 
Topology window); this is a necessary requirement to get the correct .xml files that are then necessary to work on 
the Touchscreen configurator software.
Otherwise, there may be problems with the export file as the ETS columns are not ordered as shown in the figure:

Buildings:

Topology:

Exporting files from ETS3 and importing in the software
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5.1. The "System structure" file
Overview
The "System structure" file contains all information concerning the structure of the KNX system in terms of 
buildings, floors, rooms and electric panels. This section is not limited in any way by the ETS3 software, which 
leaves the designer the freedom to organise the devices as he sees fit.  By following a certain logic in defining 
this "tree" structure (see for example the sample ETS project provided), it is possible to configure the Well-contact 
Suite software almost entirely automatically in terms of the floors, rooms and common areas of the hotel.  By 
appropriately organising the devices, it is possible to reduce the amount of work needed to configure the Well-
contact Suite software right from the ETS programming stage. The "System structure" and "Devices" files are 
interrelated in terms of logic; the first only goes as far as defining the system structure, while the second goes on 
to define the devices contained by each "terminal node" of the system structure.
The sequence of operations necessary to correctly export the above-mentioned file using the ETS3 software is 
described below.

Creating the System structure file
To create this file proceed as follows:

1.	� Select all the buildings, floors and  rooms in the ETS3 Buildings window. Then select any row in the upper 
Parent/Name section.

Exporting files from ETS3 and importing in the software
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Exporting files from ETS3 and importing in the software

2.  From the File menu choose "Extract Data (e.g. OPC)”.
The Export Foreign Format window will appear.

3.	 In the Export Foreign Format window select the "Export…" button in the "Export to CSV/XML" section.

4.	� In the Export List Content window select “All” in the "List items" section, select “XML” in the Export 
Format section and press the “OK” button.

5.	 In the window that now opens:

	 a. select the destination folder for the  System structure file;
	 b. type in the file name: System structure;
	 c. press the "SAVE" button.

NOTE: the file extension will be XML.
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5.2 The "Devices" file
Overview
The "Devices" file contains the following information for each device present in the system:
•	 physical address;
•	 name of the node containing the device in the system's tree structure (obtained from the "System structure" 

file);
•	 description assigned by the ETS designer (the person who has created the system's ETS project);
•	 application software loaded onto the device, which enables the functions it will be capable of performing to be 

identified.

Creating the Devices file
To create this file proceed as follows:

1.	� Select all the buildings, floors and rooms in the "Buildings" window of ETS. Then select any row in the lower 
"Parent/Address/Room…" section.

Exporting files from ETS3 and importing in the software
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Exporting files from ETS3 and importing in the software

2.	 From the File menu choose "Extract Data (e.g. OPC)”. 
	 The Export Foreign Format window will appear.

3.	 In the Export Foreign Format window select the "Export…" button in the "Export to CSV/XML" section.

4.	� In the Export List Content window select "All" in the "List items" section, select "XML" in the "Export 
Format" section and press the  "OK" button.

5.	 In the window that now opens:

	 a. select the destination folder for the Devices file;
	 b. type in the file name: Devices;
	 c. press the SAVE button.

NOTE: the file extension will be XML.
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Exporting files from ETS3 and importing in the software

5.3 The "Device configuration" file
Overview
For each property of each device identified uniquely by the physical programming address, the "Device 
configuration" file contains the list of group addresses assigned by the designer using ETS3.

Creating the Device configuration file
To create this file proceed as follows:

1.	 Select all the devices in the "Topology" window. Then select any row in the right-hand section.

2.	 From the File menu choose "Extract Data (e.g. OPC)”.
	 The Export Foreign Format window will appear.

3.	 In the Export Foreign Format window select the "Export…" button in the "Export to CSV/XML" section.
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Exporting files from ETS3 and importing in the software

4.	� In the Export List Content window select "All" in the "List items" section, select "XML" in the "Export 
Format" section and press the  "OK" button.

5.  In the window that now opens:

	 a. Select the destination folder for the Device configuration file.
	 b. Type in the file name: Device configuration.
	 c. Press the SAVE button.

NOTE: the file extension will be XML.
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5.4 The "ESF" file
Overview
In addition to the XML files described above (System structure, Devices, Device configuration), it is also necessary 
to export an ESF file that includes the list of all addresses defined (and assigned to at least one device) in the 
ETS project.
All the addresses will in any case be recognisable after importing the XML files.
Their tree structure can also be reconstructed from the three levels that make up the addresses. The further 
information contained in the ESF file is the name given to the nodes that make up the main group and middle 
group.
There are no constraints on how the group addresses defined in the ETS "Group Addresses" view are organised.
It is therefore up to the ETS designer to organise the addresses in such a way that they are easy to use within 
the Well-contact Suite software.
A good example of how to organise the group addresses is shown in the following figure:

Exporting files from ETS3 and importing in the software
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Exporting files from ETS3 and importing in the software

Creating the ESF file
To create this file proceed as follows:

1.	 From the File menu choose "Extract Data (e.g. OPC)”; the Export Foreign Format window will appear.

2.	 In the Export Foreign Format window, select the "Export…" button in the "Export to OPC Server" 
section.

3.	 In the window that now opens:

	 a. select the destination folder for the file.

	 b. type in the file name (the choice of the name is not bound in any way and its extension will in any case 
be ESF). 

	 c. press the SAVE button.
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Exporting files from ETS4 and importing in the software

5.5 Exporting system configuration files from ETS4 and importing in the software.

Using the Systems ► Configuration function, add the touchscreen you wish to use.

Select File ► Import from ETS4.
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Exporting files from ETS4 and importing in the software

Select the project you wish to use to configure the touchscreen and press OK to start the import.
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Configuring and updating

5.6 Configuring the touchscreen and updating the software and firmware 

Before programming the touchscreen it is important to verify that the version of the configuration software you 
are using is the latest one; to do so and if necessary download the updated version simply connect to to the 
website www.vimar.com and go to the Products Product Software  Well-Contact Plus  WCP Touchscreen 
Configurator section.

Together with the software you can also download the latest firmware version for the touchscreens 21848.1 
to be paired with the software itself: Products Product Software  Well-Contact Plus  4+4 Touchscreen 
Firmware.
After downloading the latest firmware onto your PC's Desktop, unzip the zipped folder containing the file, connect 
the touchscreen to the PC via the programming interface 01998 and run the software.

If no touchscreen projects have been created as yet, you can create a new one and upgrade as follows:
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Configuring and updating

The pop-up window will appear:

Confirm with Yes.

The touchscreen will then require calibration as if it were being powered up for the first time; on completing this 
process, the device will turn on, displaying the main screen and you can then proceed with programming the 
environment-pages.

The touchscreen is configured with the Configurator software as follows:

- start the application;

- create a new plant and add the 4+4 module touchscreens to it;

- import the 4 files previously created via ETS ("System structure", "Devices", "Device configuration" and "ESF") 
into the software. 

By adding different environment-pages for each touchscreen you can drag the control icons of the various nodes 
or of the various KNX objects onto each of these pages (this part is described in more detail in the instructions for 
using the software and the touchscreen).
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6. Touchscreen configuration parameters.

This folder manages the general configuration of the Touchscreen devices defined in a system.

Before configuring the touchscreens, it is essential to perform the import via ETS; the touchscreen module 
will only let you add the devices included in the system design phase with ETS. Then select the Touchscreen 
devices folder and tap on the "Configuration Parameters" button

The window is composed of a single folder, Touchscreen, which lets you: 

• present the information entered in the system design phase with ETS; 
• arrange and order the devices in the windows of the Touchscreens; 
• display on the PC the images of what the Touchscreen windows will look like; 
• export the data onto the Touchscreens connected to the PC; 
• update the software of the Touchscreens connected to the PC; 
• set the graphics, ie the colour of the background and buttons on the Touchscreen.

Touchscreen configuration parameters
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Touchscreen configuration parameters

You can scroll through the existing touchscreen devices, using the navigation buttons, and modify them. 

The description of the current touchscreen, which is the one selected in the folder, is shown in the window title. 

The following information, which can be edited via the modify function button , is provided for each 
touchscreen: 

• Description: description of the touchscreen.

• Address: single touchscreen address; this is needed to send the configuration to the touchscreen connected 
to the PC.

• Time: address of the datapoint for the time; if specified, the address of the datapoint for the date must also 
be entered. It must be specified as an alternative to the address of the datapoint for the date and time.
It can be entered either manually or by dragging the node, corresponding to the communication object iden-
tifying the datapoint for the time, from the tree representing the system designed with ETS; in this way the 
dragged object's address will be entered automatically.

• Date: address of the datapoint for the date; if specified, the address of the datapoint for the time must also 
be entered. It must be specified as an alternative to the address of the datapoint for the date and time.
It can be entered either manually or by dragging the node, corresponding to the communication object iden-
tifying the datapoint for the date, from the tree representing the system designed with ETS; in this way the 
dragged object's address will be entered automatically.

• Date and time: address of the datapoint for the date and time; it must be specified as an alternative to the 
address of the datapoint for the date and that for the time.
It can be entered either manually or by dragging the node, corresponding to the communication object identify-
ing the datapoint for the date and time, from the tree representing the system designed with ETS; in this way 
the dragged object's address will be entered automatically.

• Graphics: sets the colour of the touchscreen's background and buttons; the colour set by default is black.

• Degrees: sets degrees Celsius or Fahrenheit.



22

Software Configuratore touch screen per Well-contact Plus

Touchscreen configuration parameters

Entering touchscreen ETS identification data (physical address and date and time group)
For each touch screen in the ETS project it will be necessary to add a device via Systems -> Configuration as 
seen previously.

Each touchscreen must be paired with the physical address assigned in the ETS project and the value of the "date/
time" group that has been paired in ETS with the analogous datapoint of all the touchscreens or, alternatively, 
the values ​​of the two differentiated "date" and "time" groups with which the two datapoints for the touchscreens 
have been paired.

To enter these values ​, use the Modify function button  and then confirm .
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Touchscreen configuration parameters

6.1 Adding Environments 
Under the Environment control function you can add different environments to be controlled.

Select the touchscreen you wish to modify (if there is more than one) using the navigation button  
on the bar at the top left.

Press the Modify  function button.

Select Environment control on the screen on the left. 

Press the Add  button at the bottom left. This will open following window.

Enter the name of the environment and tap on Apply to confirm or Cancel to exit without adding an envi-
ronment. You will subsequently be able to add devices and/or single communication objects by select-
ing the environment you wish to populate and dragging them with the mouse pointer from the panel on 
the right to the environment page depicted in the centre, which represents the screens of the touchscreen.

To delete a previously created environment just select it with the mouse, tap on the Modify  function 
button and tap the Delete  button.
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Touchscreen configuration parameters

You can subsequently change the names of the environments using the Modify function button  at 
the bottom left.

To confirm your entries or changes and continue with the configuration, tap on the function button  
in the toolbar at the top right.

You can scroll through the existing touchscreen devices, using the navigation buttons, and modify them.

To complete the configuration, connect the touchscreen to the PC via the Vimar 01998 interface and 
 
press the Enter function button , located in the lower left button bar.

To update the software of the touchscreen, connect it to the PC via the Vimar 01998 interface and press 
the Update software function button , located in the lower left button bar. 

6.1.1 Selecting Graphics

The default colour of the background and buttons on the touchscreen is black. It can be changed 
 
by selecting another colour from the Graphics pull-down menu located next to the Description.
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Touchscreen configuration parameters

Tapping on button A will show a preview of the selected graphics. 
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6.1.2 Adding Relays

This window is used for adding and changing a relay command on the environment page of the 
touchscreen devices.

To add a relay device:

1. select the environment where you wish to add the device; 
2. click on the Modify function button .  
3.	from the section on the right showing the tree structure of the system designed with ETS, select the 

node corresponding to the device you wish to add or the node corresponding to a Boolean type single 
communication object: do not select the control devices (eg buttons), but rather the actuators.

4.	use the mouse to drag the selected node onto the central environment page representing the 
touchscreen display; when you have done this, a window will open allowing you to choose the 
type of device:

5.	select the Relay device type and press the OK function button to confirm; 

Touchscreen configuration parameters
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6.	enter and if necessary modify the information provided in the device data management window:

 

The window manages the following information:

•	 Description: description of the device on the environment page; the description of the dragged 
node is shown. The proposed description can however be modified. 

•	 Address: address of the dragged device or address of the device that contains the dragged 
single communication object; this cannot be modified; 

•	 Image: image with which the device is represented on the environment page; the image can be 
selected using the 

 
 and   function buttons or, for a wider view, the  button; 

•	 Managed communication objects: list of the communication objects provided for the device; 
a communication object may be mandatory or optional.

   To add a communication object, the node of the datapoint to be paired with the communication 
object must be selected from the tree representing the system designed with ETS; the selected 
node must then be dragged into the field next to the description of the communication object. 
If the type of datapoint is allowed for the communication object, then the description, datapoint 
code and address will be displayed.

Touchscreen configuration parameters
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    In the tree representing the system designed with ETS, the datapoints paired with the node of 
the device dragged onto the environment page are proposed for the selection; datapoints paired 
with devices other than the one dragged can in any case be selected.

   To remove the datapoint paired with a communication object, just use the  function button 
provided for each communication object. 

•	 Operation configuration: sets the Only ON, Only OFF or Toggle operation configuration. 

   Press Apply to confirm or Cancel to go back to the main screen. 

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After adding the device, you can modify both its position and settings. 

Modify position: click on the Modify function button  , in the bar at the top, and drag it with 

the mouse pointer. Confirm with the Save changes  function button   . 

Modify settings: click on the Modify function button  and double click on the button that 

corresponds to the device to be modified. The window will appear with the settings that can be 

modified. 

To delete the device, just click on the Modify function button  in the bar at the 

top, select it with the mouse and press the Del key on the PC keyboard.

 

Touchscreen configuration parameters
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6.1.3 Adding Roller Shutters and Blinds

This window is used for adding and modifying a Shutters and Blinds command on the environment 
page of touchscreen devices.

To add a Shutters and Blinds device:  

1. select the environment where you wish to add the device;  

2. click on the Modify function button  on the bar at the top

3.	from the section on the right showing the tree structure of the system designed with ETS, select 
the node corresponding to the device you wish to add: do not select the control devices (eg 
buttons), but rather the actuators.

4. use the mouse to drag the selected device onto the central environment page representing the 
touchscreen display; when you have done this, a window will open allowing you to choose the 
type of device:

Touchscreen configuration parameters
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5. select the Shutters and Blinds device type and press the OK function button to confirm 

6. enter and if necessary modify the information provided in the device data management window: 

The window manages the following information:

•	 Description: description of the device on the environment page; the description of the dragged 
node is shown. The proposed description can however be modified. 

•	 Address: address of the dragged device; this cannot be modified; 

•	 Image: image with which the device is represented on the environment page; the image can be 
selected using the 

 
  and   function buttons or, for a wider view, the  button; 

•	 Managed communication objects: list of the communication objects provided for the device; 
a communication object may be mandatory or optional.

   To add a communication object, the node of the datapoint to be paired with the communication 
object must be selected from the tree representing the system designed with ETS; the selected 
node must then be dragged into the field next to the description of the communication object. 

Touchscreen configuration parameters
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    of the communication object. If the type of datapoint is allowed for the communication object, 
    the description, datapoint code and address will be displayed.    

   In the tree representing the system designed with ETS, the datapoints paired with the node of 
the device dragged onto the environment page are proposed for the selection; datapoints paired 
with devices other than the one dragged can in any case be selected.

   To remove the datapoint paired with a communication object, just use the  function button 
provided for each communication object. 

    Press Apply to confirm or Cancel to go back to the main screen. 

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After adding the device, you can modify both its position and settings. 

Modify position: click on the Modify function button  , in the bar at the top, and drag it with 

the mouse pointer. Confirm with the Save changes function button  . 

Modify settings: click on the Modify function button   and double click on the button that 
corresponds to the device to be modified. The window will appear with the settings that can be 
modified. 

To delete the device, just click on the Modify function button  in the bar at the 

top, select it with the mouse and press the Del key on the PC keyboard.

 

Touchscreen configuration parameters
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6.1.4 Adding Dimmers

This window is used for adding and modifying a dimmer command on the environment page of 
the touchscreen devices.

To add a dimmer device: 

1. select the environment where you wish to add the device;  

2. click on the Modify function button  on the bar at the top

3.	from the section on the right showing the tree structure of the system designed with ETS, select 
the node corresponding to the device you wish to add: do not select the control devices (eg 
buttons), but rather the actuators.

 
4. use the mouse to drag the selected device onto the central environment page representing the 
touchscreen display; when you have done this, a window will open allowing you to choose the 
type of device:

Touchscreen configuration parameters
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5. select the Dimmer device type and press the OK function button to confirm 

6. enter and if necessary modify the information provided in the device data management window: 

The window manages the following information:

•	 Description: description of the device on the environment page; the description of the dragged 
node is shown. The proposed description can however be modified. 

•	 Address: address of the dragged device; this cannot be modified; 

•	 Image: image with which the device is represented on the environment page; the image can be 

selected using the   and   function buttons or, for a wider view, the   button; 

•	 Managed communication objects: list of the communication objects provided for the device; 
a communication object may be mandatory or optional.

The values to be paired are described in detail further on.

   To add a communication object, the node of the datapoint to be paired with the communication 
object must be selected from the tree representing the system designed with ETS; the selected 
node must then be dragged into the field next to the description of the communication object. 
If the type of datapoint is allowed for the communication object, then the description, datapoint 
code and address will be displayed.

Touchscreen configuration parameters
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   In the tree representing the system designed with ETS, the datapoints paired with the node of 
the device dragged onto the environment page are proposed for the selection; datapoints paired 
with devices other than the one dragged can in any case be selected.

   To remove the datapoint paired with a communication object, just use the  function button 
provided for each communication object. 

   • Dimmer step: sets the value of the dimmer step.

 Press Apply to confirm or Cancel to go back to the main screen. 

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After adding the device, you can modify both its position and settings. 

Modify position: click on the Modify function button  , in the bar at the top, and drag it with 

the mouse pointer. Confirm with the Save changes  function button  . 

Modify settings: click on the Modify function button  and double click on the button that 

corresponds to the device to be modified. The window will appear with the settings that can be 

modified. 

To delete the device, just click on the Modify  function button  in the bar at the top, select it 
with the mouse and press the Del key on the PC keyboard.
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In addition to the adjustment icon, the dimmer can also be given another icon, located next to the 
former, it will display the percentage value from 0-100% of the brightness of a dimmer lamp. 

To get this icon you need, via the "Status Control Value" datapoint, to set an icon that saves the 
dimmer adjustment percentage in real time so that the user sees the lamp's brightness:

The parameters to be set once the datapoint has been paired are highlighted in red.

Caution: the displayed "ms" has no relevance with the numeric value which will instead be a per-
centage (ranging from 0 to 100%) relating to the level of brightness of the dimmer lamp.
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KNX Dimmer configuration using the Touchscreen Configurator software.

To configure the dimmer correctly using the application, the first thing you have to do is link a num-
ber of fundamental objects to your ETS project. These are:

• Output A-> Switching

• Output A-> Relative dimming 

• Output A-> Brightness value

• Output A-> Brightness value status

• Output A-> Switching status 

The dimmer used can be configured in two different ways:

1. Dimmer with brightness bar on the touchscreen

To configure the dimmer in this way you need to add the following objects to the communication 
items required by the Touchscreen Configurator software:

Communication objects controlled Dimmer objects

ON/OFF Output A-Switching

Increase/Decrease No object

Dimming-> Output A- Brightness value

Status Output A- Switching status

Dimming Value Info Output A- Brightness value status
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The configuration described above is shown in the following figure: 

2. Dimmer with no brightness bar on the touchscreen:

To configure the dimmer in this way you need to add the following objects to the communication 
items required by the Touchscreen Configurator software:

Communication objects controlled Dimmer objects

ON/OFF Output A-Switching

Increase/Decrease Output A-> Relative dimming

Dimming-> No object

Status Output A- Switching status

Dimming Value Info No object
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The configuration described above is shown in the following figure: 
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6.1.5 HVAC settings

This window is used for adding and modifying an HVAC command on the environment page of the 
touchscreen devices.

To add an HVAC device: 

1. select the environment where you wish to add the HVAC; 

2. click on the Modify function button  on the bar at the top;

3.	from the section on the right showing the tree structure of the system designed with ETS, select 
the node corresponding to the device you wish to add: 

4. use the mouse to drag the selected device onto the central environment page representing the 
touchscreen display; when you have done this, a window will open allowing you to choose the 
type of device:

N.B. It is possible to select either Climate or Custom climate.

• Climate: Used to configure the normal thermostat, thermostat in neutral zone and to integrate 
other thermostats.

• Custom climate: To be used only for the Vimar thermostat. The following functions can be con-
trolled by the thermostat: 
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5. select the HVAC device type and press the OK function button to confirm 

6. enter and if necessary modify the information provided in the device data management window: 

   If the thermostat to be configured is art. 20430-16915-14430-02952 the objects will be doubled 
and will be displayed twice (as if the device consists of two separate thermostats A and B); the 
objects to use are those of thermostat A or thermostat B depending on the one controlled with 
the touchscreen. 

   If we wish to control both devices A and B, the selection operation must be done twice, pairing 
first the objects of thermostat A and then those of thermostat B (or vice versa); the touchscreen 
therefore displays the thermostats A and B as two separate devices.

The window manages the following information:

•	 Description: thermostat description; if the Display temperature mode is selected, it is dis-
played as a description of the device on the environment page. If the Set temperature mode is 
displayed, it is displayed as the name of the environment page. 

- edit only the mode, either comfort (icon ON) or protected (icon OFF);
- edit and view the temperature setpoint;
- view the current temperature, current setpoint and shift setpoint;
- edit and view the speed.

Important: By short-circuiting the terminals on the external temperature probe on the KNX 
Touch Screen and using the software to set the main environment of the custom thermostat 
to "default", it is possible to view this thermostat as the only main page. This function is 
suitable for hotel rooms where you wish to view a single thermostat and limit the functions 
available to the client. 
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   When adding HVAC, the description of the dragged device node is proposed; the proposed 
description can in any case be modified.

    If the window was opened to correct data, the description can only be modified if the HVAC 
display type is Display temperature.

    To modify the HVAC description entered in Set temperature mode, you must directly edit the 
description of the environment page.
If in the Environment page where the thermostat has been dragged there are already other icons 
(commands, lights, etc.) the thermostat icon may be set only to view the temperature.

•	 Address: address of the dragged device; this cannot be modified.

The configuration software also manages generic KNX thermostats, consequently some 
of the functions described below specifically support these devices.

•	 Temperature: indicates the type of display on the device on the environment page.
   If there are other elements in the environment layout, only the Display temperature command 

is enabled, otherwise you can choose between Display temperature and Set temperature.
    In the second case it is not possible to add any other elements on the page and the environment 

name is replaced by the thermostat name.

*1 

Home: The operating modes Comfort, Economy, Standby, Protected are viewed and set in the 
KNX touch screen.

Hotel: The operating modes Comfort and Protected are viewed and set in the KNX touch 
screen.

*2 

Control 3 fan speeds on/off:  Where set in the thermostat parameters, this function controls 
v1, v2, v3.

Proportional fan speed control (pure): Where set in the thermostat parameters, this function 
manages the proportional speed 0-100%.
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Proportional fan speed control: Where set in the thermostat parameters, this function manages 
the proportional speed 33-67-100%.

Fan control at 1 Bit up/Down: This function is used for system integrations where the speeds 
are managed by a 1 Bit up/Down datapoint.

*3 

Proportional valve: By selecting  the touch screen controls a proportional valve; vice versa, if 
the flag is not enabled, the touch controls an ON-OFF valve.

*4 

Read the setpoint range of the Vimar 20452 device: This function is used to read the setpoint 
of the Vimar 20452 thermostat (item no longer in the catalogue). Select  to enable.

*5 

Enable periodic device interrogation: By selecting  the touch screen automatically interro-
gates the following datapoints (where configured) every 30 s: current temperature, valve state, 
speed state, shift setpoint, current setpoint and thermostat mode state. 

*6 

Display setpoint: By selecting  instead of the current temperature the touch screen displays 
the current setpoint in the thermostat (you are advised to use this function is the parameter value 
displayed -> current setpoint in thermostat is enabled).

*7 

Different setpoints for summer/winter: This function is used when the thermostat is configured 
in the neutral zone in which the device requires summer/winter setpoints for the various HVAC 
operating modes. Select  to enable.  

*8 

Current setpoint command: The function is enabled if the device modifies the current setpoint 
without having the change the summer/winter setpoints.

Different setpoint command for each mode: The function is enabled if the device modifies the 
summer/winter setpoints of the various HVAC operating modes.  

*9 

Current setpoint state: The function is enabled if the touch screen has to read the current 
setpoint without having the read the summer/winter setpoints.

Different setpoint state for each mode: The function is enabled if the touch screen has to read 
the summer/winter setpoints of the various HVAC operating modes.

*10 

4 pipe system

2 pipe system

4 pipe system with neutral zone

For these functions, used the same settings assigned to the thermostat parameters under 
“System type”.
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*11 

Setpoint range: 

 OFF: the client cannot edit the thermostat setpoint from the touch screen.

 +1 -1 /+5 -5: the client can edit the setpoint within the set range.

 No limit: the client can edit the setpoint as required with no limits.

*12 

Offset management relative to base setpoint: If there is a shift setpoint datapoint, this function 
controls the setpoint from the touch screen. Select  to enable.

*13 

Fan interlock management: When enabled, this function will enable the fan coil speed only if 
the other two speeds are OFF; it is not possible to have two speeds active at the same time. 
Select  to enable.

*14

Incremental fan management: When enabled, this function allows the incremental fan manage-
ment; use “+” to move between the speeds incrementally, use “A” to force to automatic fan 
speed mode. Select  to enable.

    To add a communication object, the node of the datapoint to be paired with the communication 
object must be selected from the tree representing the system designed with ETS; the selected 
node must then be dragged into the field next to the description of the communication object. 
If the type of datapoint is allowed for the communication object, then the description, datapoint 
code and address will be displayed.

    In the tree representing the system designed with ETS, the datapoints paired with the node of 
the device dragged onto the environment page are proposed for the selection; datapoints paired 
with devices other than the one dragged can in any case be selected.

   To remove the datapoint paired with a communication object, simply use the function button         
provided for each communication object.

The datapoints that can be enabled depend upon the implemented functions, according to 
the thermostat to be configured.

Press Apply to confirm or Cancel to go back to the main screen.

7.	confirm the set configuration via the Save changes function button   in the top toolbar.

After adding the device, you can modify both its position and settings. 

Modify position (for Display temperature only): click on the Modify function button  , in 
the bar at the top, and drag it with the mouse pointer. Confirm with the Save changes function 
button  . 
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Modify settings: click on the Modify function button  and double click on any element that 
composes the HVAC to be modified. The window will appear with the settings that can be modified. 
The settings can be modified for both the HVAC added in Display temperature mode and for the 
one added in Set temperature mode. 

To delete the elements regarding the HVAC from the environment page, for both the Display 

temperature and Set temperature modes, just click on the Modify function button in 

the bar at the top, select any element that composes the HVAC and press the Del key on the PC 

keyboard.
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Configuration parameters for thermostat 20430-19430-14430-02952

To configure the thermostat correctly using the application, the first thing you have to do is link a 
number of fundamental objects to your ETS project. These are:

• Enable-> Summer/Winter

• Shift Setpoint-> Setpoint

• OFF-> Fan Inputs

• Speed V1-> Fan Inputs

• Speed V2-> Fan Inputs

• Speed V3-> Fan Inputs

• Automatic-> Fan Inputs

• Thermostat Mode-> Mode

• Actual Temperature -> Temperature 

• State-> Summer/Winter

• Actual Setpoint-> Setpoint

• Speed V1-> Fan Outputs

• Speed V2-> Fan Outputs

• Speed V3-> Fan Outputs

• Thermostat mode -> Mode State

• 2-tube system valve (cooling/heating)

• 4-tube system valve (heating)

• 4-tube system valve (cooling)

Mid Season
This function is available from the supervisor only for systems configured with primary and seconda-
ry output; when active, it exchanges the 2 main and secondary outputs (and the related parameters 
too). It is recommended for making minor adjustments (such as +/-2 °C) during mid season periods 
where it may be more convenient to operate only the secondary circuit (for instance Split).

N.B.:
Obviously the valve is added to the project and to the software according to the system 
installed.
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Now we can describe step by step how to configure the fan coil thermostat using the Touchscreen 
Configurator software. 

Having imported the ETS project, we proceed to configure a thermostat. 

First, we create a new environment and drag a thermostat into it. The application will ask to specify 
the “type” of device we are configuring, by selecting one of the following options:  

• Climate: The thermostat is used for temperature control in a home, hotel or a system integration.

• Custom climate: The thermostat is used in a hotel room in which a single main page has been 
configured (refer to the following description).

Another window will open: here we must specify whether we wish to set or view the temperature 
(two ways of viewing the thermostat on the touch screen, as desired).  
Then we drag the thermostat objects into the respective items requested by the application.
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Normal thermostat configuration
To configure the normal thermostat, see the example shown in the folder "Example of standard 
thermostat" which can be downloaded from the website www.vimar.com in the section Software 
 Management Software for Well-contact Plus (KNX). The folder contains the project in EST5 
and the exported Touch Screen Configurator system.

Neutral zone thermostat configuration:
To configure the thermostat in neutral zone, see the example shown in the folder "Example of neu-
tral zone thermostat" which can be downloaded from the website www.vimar.com in the section 
Software  Management Software for Well-contact Plus (KNX). The folder contains the project 
in EST5 and the exported Touch Screen Configurator system.

Custom thermostat configuration:
To configure the custom thermostat, see the example shown in the folder "Example of custom 
thermostat" which can be downloaded from the website www.vimar.com in the section Software 
 Management Software for Well-contact Plus (KNX). The folder contains the project in EST5 
and the exported Touch Screen Configurator system.
Important: For the custom configuration, carry out the following:

 - Short-circuit the terminal on the touch screen exterior temperature probe.

 - The thermostat will be displayed in the touch screen as follows:

- Touch  to place the thermostat in Comfort mode, or touch  for Protected mode.

We can view the setpoint, fan coil speeds and valve state.
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Configuring the KNX weather station, Vimar art. 01546

Drag the device into an environment in the device and then define it as “weather station“:

On the specific screen enter the various weather station datapoints which can be displayed:

The datapoints paired with the measurable values are: 

- Brightness (LUX)

- Twilight (Day or night)

- Wind speed	 (0 - 70 m/s resolution 1m/s)

- Heated rain sensor (On/Off)

- Current temperature (-40/+80°C resolution 0.1°C)

These datapoints do not have to be configured and can be added according to what you need 
to view.
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The atmospheric pressure value is not supplied directly by the weather station 01546; it can 
however be paired with a specific datapoint as, to read the pressure value, a non-Vimar KNX 
device may be used. 
The pressure icon will obviously be present only if the function is effectively used.

Example of displayed values read by the weather station on the touchscreen:
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Possible weather conditions that can be displayed on the weather station screen.

The distinction between rain and snow is combined, i.e according to whether it is raining or 
snowing ("Switching output rain" communication object) and the measured air temperature value 
("Measured temperature value" communication object).

The icons paired with the weather status shown on the touchscreen are the following:

=  day without rain

=  night without rain

=  rain with temperature above 2 °C

=  rain with temperature between 0 and 2 °C

=  rain with temperature below 0 °C
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6.1.6 Adding a Single communication object

This window is used for adding and modifying a single communication object on the environment 
page of touchscreen devices.

To add a communication object: 

1. select the environment where you wish to add the communication object; 

2  click on the Modify function button  on the bar at the top;

3.	from the section on the right showing the tree structure of the system designed with ETS, select 
the node corresponding to the communication object you wish to add: do not select the control 
devices (eg buttons), but rather the actuators.

4. use your mouse to drag the selected communication object onto the central environment page 
representing the touchscreen display; 

5. for Boolean type communication objects only, a window will open allowing you to choose the 
type of device; select Boolean device type to add the selected node as a single communication 
object. Otherwise, select the Relay device type to add the selected node as a relay command.
Press the OK function button to confirm.
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6. enter and if necessary modify the required information in the data management window for the 
communication object; the data management window varies according to the type of communica-
tion object selected.

The following types of communication objects can be managed:
-  Boolean
-  3-Bit Controlled
-  Boolean subtypes
-  8-Bit Signed/Unsigned, 2-Octet Signed/Unsigned/Float, 4-Octet Signed/Unsigned/Float 
-  Scene Control.
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The window manages the following information:

•	 Description: description of the device on the environment page; the description of the dragged 
 
node is shown; the proposed description can however be modified. 

•	 Image: image with which the communication object is represented on the environment page; 

the image can be selected using the   and   function buttons or, for a wider view, the 

 button; (only for the communication objects with type other than "8-Bit Signed/Unsigned, 
2-Octet Signed/Unsigned/Float, 4-Octet Signed/Unsigned/Float").
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•	 Type: type of communication object (datapoint) which can be selected from a specific list;

•	 Group address: address of the dragged communication object; this cannot be modified.

Only for the communication objects with type 8-Bit Signed/Unsigned, 2-Octet Signed/Unsigned/
Float, 4-Octet Signed/Unsigned/Float,the following information is managed: 

•	 Unit of measurement: unit of measurement; this can be selected from a list of available values; 

•	 Conversion factor: conversion of value in order to adapt the display to the particular/usual case 
of use; it can be selected from a list of available values; 

•	 Scaling: scaling which can be selected from a list of available values; 

•	 Number of decimals: number of decimal digits to be displayed. 

The following information is provided only for communication objects of the Scenario type:

•	 Number of scenario: number of the scenario which can be selected from a list. 

An icon can be displayed that simply calls up the scenario or an icon that, when tapped, calls up 
the scenario, when pressed for approximately 2 s, sends a save-scenario message over the bus 
and when pressed a second time sends a subsequent end saving message; this function is useful 
for modifying a scenario created previously.   
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Press Apply to confirm or Cancel to go back to the main screen.

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After inserting the communication object, you can modify both its position and the 
settings. 

Modify position: click on the Modify function button  , in the bar at the top, and drag it with 

the mouse pointer. Confirm with the Save changes function button  . 

Modify settings: click on the Modify function button  and double click on the button that 
corresponds to the communication object to be modified. The window will appear with the settings 
that can be modified. 

To delete the communication object from the environment page, just click on the Modify func-

tion button  in the bar at the top, select it with the mouse and press the Del key on the PC 

keyboard.
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6.2 Selecting the default page
The default page is the screen of the touchscreen which is displayed when the touchscreen returns to 
energy savings/screensaver mode. 

To define the default page: 

1.   select the page to set as the default (in this example we have inserted the Main Menu screen);

2.	 click on the Modify function button  ; 

3.	� click on the Set default button    in the toolbar at the bottom;

4.  confirm with the Save changes button  in the toolbar at the top.
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7. Help

The application provides access to online help via the menu Help ► Online Help of the Touchscreen 
Configurator software or by tapping on F1 in the main windows. 

This is contextual help, which means that it displays the text relating to the window where it was called up. 
By selecting the menu Help ► Online Help, help is activated for the window that is on top of all the active 
ones in the application.

Help
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Section 2
3-module colour touchscreen  21849.1
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1. Minimum hardware and software requirements

Software:

• Microsoft Windows 98/2000/XP/Vista/7/8/10/11 Operating System.
• Linux RedHat 8.0/Fedora Core 3,4,5,10/Ubuntu 8.10 Operating System.

Hardware:

• 100 MB of free space on hard disk
• Mouse
• CD-ROM
• Serial Port

2. Installing the program

The user will be guided through the installation of the program by a special wizard; the required information for 
this is all given in the manual for the software and for the PC.

2.1 Configuring systems for adding the touchscreen
This window lets you define the devices and systems that have to be paired with the plant to be managed.  
To activate this window, there should be no active modules: all the modules must then be closed before 
configuring the plant's systems.

You can access this function from the menu Systems ► Configuration.
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Requirements - Installation - Functions

3. Description of Touchscreen configurator software for Well-contact Plus

3.1 Functions
The Touchscreen configurator software for Well-contact Plus can be used to:  
1.	configure the touchscreens, adding various environments and, for each environment, various devices; 
2.	display and modify the touchscreen layout, adding and deleting devices or changing the position of the 

existing ones; 
3.	send configurations to the touchscreens connected to the PC; 
4.	update software on touchscreen devices.  

3.2 General notes

3.2.1 Non-permitted characters

The following characters may not be inserted in the text fields:

&

<

>

Each part of the application will now be analyzed, and its operation explained. 

The descriptions used in the touchscreens should be without accented characters.
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4. Functions.

The following is a detailed analysis of the application's functions.

Legend of function buttons common to the entire application:

Navigation buttons:

 	 Go to first item in folder

 	 Go to previous item from the one displayed

 	 Go to next item from the one displayed

 	 Go to last item in folder

Function buttons:

 	 Lets you modify the data displayed

 	 Confirms all the changes made (adding a new item or modifying an existing item)

 	 Cancels the last changes or new addition and restores the previous state

Touchscreen management buttons:

 	 Lets you add a new item in the folder

 	 Deletes the item displayed

 	 Sends the data set on the software to the touchscreen

 	 Updates the touchscreen software

The following is a detailed description of the application windows and the available operations.

Functions
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5. Exporting system configuration files from ETS3 and importing in the software.

The procedure for importing system data uses four files to describe the system. These files must be created in 
advance using the ETS3 export procedure and are the following:

•	 System structure file (XML type file)
•	 Devices file (XML type file)
•	 Device configuration file (XML type file)
•	 ESF file (ESF type file)

These four files contain information on system topology, installed devices, the group addresses assigned to the 
various devices and the list of all defined addresses. The following sections describe the four files and how to 
create them via ETS3.

IT IS IN ANY CASE MANDATORY TO ADD THE TOUCHSCREENS TO THE ETS PROJECT TOO AND ADD 
THEIR "DATE", "TIME" and "DATE-TIME" OBJECTS TO THREE GROUPS TO BE CREATED WITH THE 
SAME NAME AS THE OBJECTS OF THE TOUCHSCREEN, THEN USING THE PHYSICAL ADDRESSES 
OF THE TOUCHSCREENS ALSO IN THE CONFIGURATION SOFTWARE (in the "address", "time", "date", 
"date and time" fields).

CAUTION: In ETS, the sequence of the columns must always be the same (for the Buildings window and for the 
Topology window); this is a necessary requirement to get the correct .xml files that are then necessary to work on 
the Touchscreen configurator software.
Otherwise, there may be problems with the export file as the ETS columns are not ordered as shown in the figure:

Buildings:

Topology:

Exporting files from ETS3 and importing in the software
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5.1. The "System structure" file
Overview
The "System structure" file contains all information concerning the structure of the KNX system in terms of 
buildings, floors, rooms and electric panels. This section is not limited in any way by the ETS3 software, which 
leaves the designer the freedom to organise the devices as he sees fit.  By following a certain logic in defining 
this "tree" structure (see for example the sample ETS project provided), it is possible to configure the Well-contact 
Suite software almost entirely automatically in terms of the floors, rooms and common areas of the hotel.  By 
appropriately organising the devices, it is possible to reduce the amount of work needed to configure the Well-
contact Suite software right from the ETS programming stage. The "System structure" and "Devices" files are 
interrelated in terms of logic; the first only goes as far as defining the system structure, while the second goes on 
to define the devices contained by each "terminal node" of the system structure.
The sequence of operations necessary to correctly export the above-mentioned file using the ETS3 software is 
described below.

Creating the System structure file
To create this file proceed as follows:

1.	� Select all the buildings, floors and  rooms in the ETS3 Buildings window. Then select any row in the upper 
Parent/Name section.

Exporting files from ETS3 and importing in the software



67

Software Configuratore touch screen per Well-contact Plus

Exporting files from ETS3 and importing in the software

2.  From the File menu choose "Extract Data (e.g. OPC)”.
The Export Foreign Format window will appear.

3.	 In the Export Foreign Format window select the "Export…" button in the "Export to CSV/XML" section.

4.	� In the Export List Content window select “All” in the "List items" section, select “XML” in the Export 
Format section and press the “OK” button.

5.	 In the window that now opens:

	 a. select the destination folder for the  System structure file;
	 b. type in the file name: System structure;
	 c. press the "SAVE" button.

NOTE: the file extension will be XML.
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5.2 The "Devices" file
Overview
The "Devices" file contains the following information for each device present in the system:
•	 physical address;
•	 name of the node containing the device in the system's tree structure (obtained from the "System structure" 

file);
•	 description assigned by the ETS designer (the person who has created the system's ETS project);
•	 application software loaded onto the device, which enables the functions it will be capable of performing to be 

identified.

Creating the Devices file
To create this file proceed as follows:

1.	� Select all the buildings, floors and rooms in the "Buildings" window of ETS. Then select any row in the 
lower "Parent/Address/Room…" section.

Exporting files from ETS3 and importing in the software
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Exporting files from ETS3 and importing in the software

2.	 From the File menu choose "Extract Data (e.g. OPC)”. 
	 The Export Foreign Format window will appear.

3.	 In the Export Foreign Format window select the "Export…" button in the "Export to CSV/XML" section.

4.	� In the Export List Content window select ”All” in the "List items" section, select “XML” in the "Export 
Format" section and press the “OK” button.

5.	 In the window that now opens:

	 a. select the destination folder for the Devices file;
	 b. type in the file name: Devices;
	 c. press the SAVE button.

NOTE: the file extension will be XML.
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Exporting files from ETS3 and importing in the software

5.3 The "Device configuration" file
Overview
For each property of each device identified uniquely by the physical programming address, the "Device 
configuration" file contains the list of group addresses assigned by the designer using ETS3.

Creating the Device configuration file
To create this file proceed as follows:

1.	 Select all the devices in the "Topology" window. Then select any row in the right-hand section.

2.	 From the File menu choose "Extract Data (e.g. OPC)”.
	 The Export Foreign Format window will appear.

3.	 In the Export Foreign Format window select the "Export…" button in the "Export to CSV/XML" section.
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Exporting files from ETS3 and importing in the software

4.	� In the Export List Content window select "All" in the "List items" section, select "XML" in the "Export 
Format" section and press the  "OK" button.

5.  In the window that now opens:

	 a. Select the destination folder for the Device configuration file.
	 b. Type in the file name: Device configuration.
	 c. Press the SAVE button.

NOTE: the file extension will be XML.



72

Software Configuratore touch screen per Well-contact Plus

5.4 The "ESF" file
Overview
In addition to the XML files described above (System structure, Devices, Device configuration), it is also necessary 
to export an ESF file that includes the list of all addresses defined (and assigned to at least one device) in the 
ETS project.
All the addresses will in any case be recognisable after importing the XML files.
Their tree structure can also be reconstructed from the three levels that make up the addresses. The further 
information contained in the ESF file is the name given to the nodes that make up the main group and middle 
group.
There are no constraints on how the group addresses defined in the ETS "Group Addresses" view are organised.
It is therefore up to the ETS designer to organise the addresses in such a way that they are easy to use within 
the Well-contact Suite software.
A good example of how to organise the group addresses is shown in the following figure:

Exporting files from ETS3 and importing in the software
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Exporting files from ETS3 and importing in the software

Creating the ESF file
To create this file proceed as follows:

1.	 From the File menu choose "Extract Data (e.g. OPC)”; the Export Foreign Format window will appear.

2.	 In the Export Foreign Format window, select the "Export…" button in the "Export to OPC Server" 
section.

3.	 In the window that now opens:

	 a. select the destination folder for the file.

	 b. type in the file name (the choice of the name is not bound in any way and its extension will in any case 
be ESF). 

	 c. press the SAVE button.
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Exporting files from ETS4 and importing in the software

5.5 Exporting system configuration files from ETS4 and importing in the software.

Using the Systems  Configuration function, add the touchscreen you wish to use.
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Exporting files from ETS4 and importing in the software

Select the project you wish to use to configure the touchscreen and press OK to start the import.
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Configuring and updating

5.6 Configuring the touchscreen and updating the software and firmware 

Before programming the touchscreen it is important to verify that the version of the configuration software you 
are using is the latest one; to do so and if necessary download the updated version simply connect to to the 
website www.vimar.com and go to the Products Product Software  Well-Contact Plus  WCP Touchscreen 
Configurator section.

Together with the software you can also download the latest firmware version for the touchscreens 21848.1 
to be paired with the software itself: Products Product Software  Well-Contact Plus  4+4 Touchscreen 
Firmware.
After downloading the latest firmware onto your PC's Desktop, unzip the zipped folder containing the file, connect 
the touchscreen to the PC via the programming interface 01998 and run the software.

If no touchscreen projects have been created as yet, you can create a new one and upgrade as follows:
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Configuring and updating

The pop-up window will appear:

Confirm with Yes.

The touchscreen will then require calibration as if it were being powered up for the first time; on completing this 
process, the device will turn on, displaying the main screen and you can then proceed with programming the 
environment-pages.

The touchscreen is configured with the Configurator software as follows:

- start the application;

- create a new plant and add the 4+4 module touchscreens to it;

- import the 4 files previously created via ETS ("System structure", "Devices", "Device configuration" and "ESF") 
into the software. 

By adding different environment-pages for each touchscreen you can drag the control icons of the various nodes 
or of the various KNX objects onto each of these pages (this part is described in more detail in the instructions for 
using the software and the touchscreen).
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6. Touchscreen configuration parameters.

This folder manages the general configuration of the Touchscreen devices defined in a system.

Before configuring the touchscreens, it is essential to perform the import via ETS; the touchscreen module 
will only let you add the devices included in the system design phase with ETS. Then select the Touchscreen 
devices folder and tap on the "Configuration Parameters" button

The window is composed of a single folder, Touchscreen, which lets you: 

• present the information entered in the system design phase with ETS; 
• arrange and order the devices in the windows of the Touchscreens; 
• display on the PC the images of what the Touchscreen windows will look like; 
• export the data onto the Touchscreens connected to the PC; 
• update the software of the Touchscreens connected to the PC; 
• set the graphics, ie the colour of the background and buttons on the Touchscreen.

Touchscreen configuration parameters
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Touchscreen configuration parameters

You can scroll through the existing touchscreen devices, using the navigation buttons, and modify them. 

The description of the current touchscreen, which is the one selected in the folder, is shown in the window title. 

The following information, which can be edited via the modify function button , is provided for each 
touchscreen: 

• Description: description of the touchscreen.

• Address: single touchscreen address; this is needed to send the configuration to the touchscreen connected 
to the PC.

• Time: address of the datapoint for the time; if specified, the address of the datapoint for the date must also 
be entered. It must be specified as an alternative to the address of the datapoint for the date and time.
It can be entered either manually or by dragging the node, corresponding to the communication object iden-
tifying the datapoint for the time, from the tree representing the system designed with ETS; in this way the 
dragged object's address will be entered automatically.

• Date: address of the datapoint for the date; if specified, the address of the datapoint for the time must also 
be entered. It must be specified as an alternative to the address of the datapoint for the date and time.
It can be entered either manually or by dragging the node, corresponding to the communication object iden-
tifying the datapoint for the date, from the tree representing the system designed with ETS; in this way the 
dragged object's address will be entered automatically.

• Date and time: address of the datapoint for the date and time; it must be specified as an alternative to the 
address of the datapoint for the date and that for the time.
It can be entered either manually or by dragging the node, corresponding to the communication object identify-
ing the datapoint for the date and time, from the tree representing the system designed with ETS; in this way 
the dragged object's address will be entered automatically.

• Graphics: sets the colour of the touchscreen's background and buttons; the colour set by default is black.

• Degrees: sets degrees Celsius or Fahrenheit.
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Touchscreen configuration parameters

Entering touchscreen ETS identification data (physical address and date and time group)
For each touch screen in the ETS project it will be necessary to add a device via Systems -> Configuration as 
seen previously.

Each touchscreen must be paired with the physical address assigned in the ETS project and the value of the "date/
time" group that has been paired in ETS with the analogous datapoint of all the touchscreens or, alternatively, 
the values ​​of the two differentiated "date" and "time" groups with which the two datapoints for the touchscreens 
have been paired.

To enter these values ​, use the Modify function button  and then confirm .
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Touchscreen configuration parameters

6.1 Adding Environments 
Under the Environment control function you can add different environments to be controlled.

Select the touchscreen you wish to modify (if there is more than one) using the navigation button  
on the bar at the top left.

Press the Modify  function button.

Select Environment control on the screen on the left. 

Press the Add  button at the bottom left. This will open following window.

Enter the name of the environment and tap on Apply to confirm or Cancel to exit without adding an envi-
ronment. You will subsequently be able to add devices and/or single communication objects by select-
ing the environment you wish to populate and dragging them with the mouse pointer from the panel on 
the right to the environment page depicted in the centre, which represents the screens of the touchscreen.

To delete a previously created environment just select it with the mouse, tap on the Modify  function 
button and tap the Delete  button.
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You can subsequently change the names of the environments using the Modify function button  at 
the bottom left.

To confirm your entries or changes and continue with the configuration, tap on the function button  
in the toolbar at the top right.

You can scroll through the existing touchscreen devices, using the navigation buttons, and modify them.

To complete the configuration, connect the touchscreen to the PC via the Vimar 01998 interface and 
press the Enter function button , located in the lower left button bar.

To update the software of the touchscreen, connect it to the PC via the Vimar 01998 interface and press 
the Update software function button , located in the lower left button bar. 

6.1.1 Selecting Graphics

The default colour of the background and buttons on the touchscreen is black. It can be changed 
by selecting another colour from the Graphics pull-down menu located next to the Description.

Touchscreen configuration parameters
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Tapping on button A will show a preview of the selected graphics. 

Touchscreen configuration parameters
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6.1.2 Adding Relays

This window is used for adding and changing a relay command on the environment page of the 
touchscreen devices.

To add a relay device:

1. select the environment where you wish to add the device; 
2. click on the Modify function button .  
3.	from the section on the right showing the tree structure of the system designed with ETS, select the 

node corresponding to the device you wish to add or the node corresponding to a Boolean type sin-
gle communication object: do not select the control devices (eg buttons), but rather the actuators.

4.	use the mouse to drag the selected node onto the central environment page representing the 
touchscreen display; when you have done this, a window will open allowing you to choose the 
type of device:

Touchscreen configuration parameters
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5.	select the Relay device type and press the OK function button to confirm; 

6.	enter and if necessary modify the information provided in the device data management window:

 

The window manages the following information:

•	 Description: description of the device on the environment page; the description of the dragged 
node is shown. The proposed description can however be modified. 

•	 Address: address of the dragged device or address of the device that contains the dragged 
single communication object; this cannot be modified; 

•	 Image: image with which the device is represented on the environment page; the image can be 
selected using the 

 
 and   function buttons or, for a wider view, the  button; 

•	 Managed communication objects: list of the communication objects provided for the device; 
a communication object may be mandatory or optional.

   To add a communication object, the node of the datapoint to be paired with the communication 
object must be selected from the tree representing the system designed with ETS; the selected 
node must then be dragged into the field next to the description of the communication object. 
If the type of datapoint is allowed for the communication object, then the description, datapoint 
code and address will be displayed.

Touchscreen configuration parameters
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    In the tree representing the system designed with ETS, the datapoints paired with the node of 
the device dragged onto the environment page are proposed for the selection; datapoints paired 
with devices other than the one dragged can in any case be selected.

   To remove the datapoint paired with a communication object, just use the  function button 
provided for each communication object. 

•	 Operation configuration: sets the Only ON, Only OFF or Toggle operation configuration. 

   Press Apply to confirm or Cancel to go back to the main screen. 

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After adding the device, you can modify both its position and settings. 

Modify position: click on the Modify function button  , in the bar at the top, and drag it with 
the mouse pointer. Confirm with the Save changes function button . 

Modify settings: click on the Modify function button  and double click on the button that 
corresponds to the device to be modified. The window will appear with the settings that can be 
modified. 

To delete the device, just click on the Modify  function button  in the bar at the top, select it 
with the mouse and press the Del key on the PC keyboard.

 

Touchscreen configuration parameters
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6.1.3 Adding Roller Shutters and Blinds

This window is used for adding and modifying a Shutters and Blinds command on the environment 
page of touchscreen devices.

To add a Shutters and Blinds device:  

1. select the environment where you wish to add the device;  

2. click on the Modify function button  on the bar at the top

3.	from the section on the right showing the tree structure of the system designed with ETS, select 
the node corresponding to the device you wish to add: do not select the control devices (eg 
buttons), but rather the actuators.

4. use the mouse to drag the selected device onto the central environment page representing the 
touchscreen display; when you have done this, a window will open allowing you to choose the 
type of device:

Touchscreen configuration parameters
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5. select the Shutters and Blinds device type and press the OK function button to confirm 

6. enter and if necessary modify the information provided in the device data management window: 

The window manages the following information:

•	 Description: description of the device on the environment page; the description of the dragged 
node is shown. The proposed description can however be modified. 

•	 Address: address of the dragged device; this cannot be modified; 

•	 Image: image with which the device is represented on the environment page; the image can be 
selected using the 

 
 and  function buttons or, for a wider view, the  button; 

•	 Managed communication objects: list of the communication objects provided for the device; 
a communication object may be mandatory or optional.

   To add a communication object, the node of the datapoint to be paired with the communication 
object must be selected from the tree representing the system designed with ETS; the selected 
node must then be dragged into the field next to the description of the communication object. 

Touchscreen configuration parameters
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    of the communication object. If the type of datapoint is allowed for the communication object, 
    the description, datapoint code and address will be displayed.    

   In the tree representing the system designed with ETS, the datapoints paired with the node of 
the device dragged onto the environment page are proposed for the selection; datapoints paired 
with devices other than the one dragged can in any case be selected.

   To remove the datapoint paired with a communication object, just use the  function button 
provided for each communication object. 

    Press Apply to confirm or Cancel to go back to the main screen. 

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After adding the device, you can modify both its position and settings. 

Modify position: click on the Modify function button  , in the bar at the top, and drag it with 
the mouse pointer. Confirm with the Save changes function button . 

Modify settings: click on the Modify function button  and double click on the button that 
corresponds to the device to be modified. The window will appear with the settings that can be 
modified. 

To delete the device, just click on the Modify  function button  in the bar at the top, select it 
with the mouse and press the Del key on the PC keyboard.

 

Touchscreen configuration parameters
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6.1.4 Adding Dimmers

This window is used for adding and modifying a dimmer command on the environment page of 
the touchscreen devices.

To add a dimmer device: 

1. select the environment where you wish to add the device;  

2. click on the Modify function button  on the bar at the top

3.	from the section on the right showing the tree structure of the system designed with ETS, select 
the node corresponding to the device you wish to add: do not select the control devices (eg 
buttons), but rather the actuators.

 
4. use the mouse to drag the selected device onto the central environment page representing the 
touchscreen display; when you have done this, a window will open allowing you to choose the 
type of device:

Touchscreen configuration parameters
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5. select the Dimmer device type and press the OK function button to confirm 

6. enter and if necessary modify the information provided in the device data management window: 

The window manages the following information:

•	 Description: description of the device on the environment page; the description of the dragged 
node is shown. The proposed description can however be modified. 

•	 Address: address of the dragged device; this cannot be modified; 

•	 Image: image with which the device is represented on the environment page; the image can be 
selected using the 

 
 and  function buttons or, for a wider view, the   button; 

•	 Managed communication objects: list of the communication objects provided for the device; 
a communication object may be mandatory or optional.

The values to be paired are described in detail further on.

   To add a communication object, the node of the datapoint to be paired with the communication 
object must be selected from the tree representing the system designed with ETS; the selected 
node must then be dragged into the field next to the description of the communication object. 
If the type of datapoint is allowed for the communication object, then the description, datapoint 
code and address will be displayed.

Touchscreen configuration parameters
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   In the tree representing the system designed with ETS, the datapoints paired with the node of 
the device dragged onto the environment page are proposed for the selection; datapoints paired 
with devices other than the one dragged can in any case be selected.

   To remove the datapoint paired with a communication object, just use the   function button 
provided for each communication object. 

   • Dimmer step: sets the value of the dimmer step.

 Press Apply to confirm or Cancel to go back to the main screen. 

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After adding the device, you can modify both its position and settings. 

Modify position: click on the Modify function button  , in the bar at the top, and drag it with 
the mouse pointer. Confirm with the Save changes function button . 

Modify settings: click on the Modify function button  and double click on the button that 
corresponds to the device to be modified. The window will appear with the settings that can be 
modified. 

To delete the device, just click on the Modify  function button  in the bar at the top, select it 
with the mouse and press the Del key on the PC keyboard.

 

Touchscreen configuration parameters
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In addition to the adjustment icon, the dimmer can also be given another icon, located next to the 
former, it will display the percentage value from 0-100% of the brightness of a dimmer lamp. 

To get this icon you need, via the "Status Control Value" datapoint, to set an icon that saves the 
dimmer adjustment percentage in real time so that the user sees the lamp's brightness:

The parameters to be set once the datapoint has been paired are highlighted in red.

Caution: the displayed "ms" has no relevance with the numeric value which will instead be a per-
centage (ranging from 0 to 100%) relating to the level of brightness of the dimmer lamp.

Touchscreen configuration parameters
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KNX Dimmer configuration using the Touchscreen Configurator software.

To configure the dimmer correctly using the application, the first thing you have to do is link a num-
ber of fundamental objects to your ETS project. These are:

• Output A-> Switching

• Output A-> Relative dimming 

• Output A-> Brightness value

• Output A-> Brightness value status

• Output A-> Switching status 

The dimmer used can be configured in two different ways:

1. Dimmer with brightness bar on the touchscreen

To configure the dimmer in this way you need to add the following objects to the communication 
items required by the Touchscreen Configurator software:

Communication objects controlled Dimmer objects

ON/OFF Output A-Switching

Increase/Decrease No object

Dimming-> Output A- Brightness value

Status Output A- Switching status

Dimming Value Info Output A- Brightness value status

Touchscreen configuration parameters
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The configuration described above is shown in the following figure: 

2. Dimmer with no brightness bar on the touchscreen:

To configure the dimmer in this way you need to add the following objects to the communication 
items required by the Touchscreen Configurator software:

Communication objects controlled Dimmer objects

ON/OFF Output A-Switching

Increase/Decrease Output A-> Relative dimming

Dimming-> No object

Status Output A- Switching status

Dimming Value Info No object

 

Touchscreen configuration parameters
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The configuration described above is shown in the following figure: 

Touchscreen configuration parameters
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6.1.5 HVAC settings

This window is used for adding and modifying an HVAC command on the environment page of the 
touchscreen devices.

To add an HVAC device: 

1. select the environment where you wish to add the HVAC; 

2. click on the Modify function button  on the bar at the top;

3.	from the section on the right showing the tree structure of the system designed with ETS, select 
the node corresponding to the device you wish to add: 

4. use the mouse to drag the selected device onto the central environment page representing the 
touchscreen display; when you have done this, a window will open allowing you to choose the 
type of device:

• Climate: Used to configure the normal thermostat, thermostat in neutral zone and to integrate 
other thermostats.

Touchscreen configuration parameters
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5. select the HVAC device type and press the OK function button to confirm 

6. enter and if necessary modify the information provided in the device data management window: 

    If the thermostat to be configured is art. 20430-16915-14430-02952 the objects will be doubled 
and will be displayed twice (as if the device consists of two separate thermostats A and B); the 
objects to use are those of thermostat A or thermostat B depending on the one controlled with 
the touchscreen. 

   If we wish to control both devices A and B, the selection operation must be done twice, pairing 
first the objects of thermostat A and then those of thermostat B (or vice versa); the touchscreen 
therefore displays the thermostats A and B as two separate devices.

The window manages the following information:

•	 Description: thermostat description; if the Display temperature mode is selected, it is dis-
played as a description of the device on the environment page. If the Set temperature mode is 
displayed, it is displayed as the name of the environment page. 

    When adding HVAC, the description of the dragged device node is proposed; the proposed 
description can in any case be modified.

    If the window was opened to correct data, the description can only be modified if the HVAC 
display type is Display temperature.

    To modify the HVAC description entered in Set temperature mode, you must directly edit the 
description of the environment page.
If in the Environment page where the thermostat has been dragged there are already other icons 
(commands, lights, etc.) the thermostat icon may be set only to view the temperature.

Touchscreen configuration parameters
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•	 Address: address of the dragged device; this cannot be modified.

The configuration software also manages generic KNX thermostats, consequently some 
of the functions described below specifically support these devices.

•	 Temperature: indicates the type of display on the device on the environment page.
   If there are other elements in the environment layout, only the Display temperature command 

is enabled, otherwise you can choose between Display temperature and Set temperature.
    In the second case it is not possible to add any other elements on the page and the environment 

name is replaced by the thermostat name.

*1 

Home: The operating modes Comfort, Economy, Standby, Protected are viewed and set in the 
KNX touch screen.

Hotel: The operating modes Comfort and Protected are viewed and set in the KNX touch 
screen.

*2 

Control 3 fan speeds on/off:  Where set in the thermostat parameters, this function controls 
v1, v2, v3.

Proportional fan speed control (pure): Where set in the thermostat parameters, this function 
manages the proportional speed 0-100%.

Proportional fan speed control: Where set in the thermostat parameters, this function manages 
the proportional speed 33-67-100%.

Fan control at 1 Bit up/Down: This function is used for system integrations where the speeds 
are managed by a 1 Bit up/Down datapoint.

*3 

Proportional valve: By selecting  the touch screen controls a proportional valve; vice versa, if 
the flag is not enabled, the touch controls an ON-OFF valve.

Touchscreen configuration parameters
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*4 

Read the setpoint range of the Vimar 20452 device: This function is used to read the setpoint 
of the Vimar 20452 thermostat (item no longer in the catalogue). Select  to enable.

*5 

Enable periodic device interrogation: By selecting  the touch screen automatically interro-
gates the following datapoints (where configured) every 30 s: current temperature, valve state, 
speed state, shift setpoint, current setpoint and thermostat mode state. 

*6 

Display setpoint: By selecting  instead of the current temperature the touch screen displays 
the current setpoint in the thermostat (you are advised to use this function is the parameter value 
displayed -> current setpoint in thermostat is enabled).

*7 

Different setpoints for summer/winter: This function is used when the thermostat is configured 
in the neutral zone in which the device requires summer/winter setpoints for the various HVAC 
operating modes. Select  to enable.  

*8 

Current setpoint command: The function is enabled if the device modifies the current setpoint 
without having the change the summer/winter setpoints.

Different setpoint command for each mode: The function is enabled if the device modifies the 
summer/winter setpoints of the various HVAC operating modes.  

*9 

Current setpoint state: The function is enabled if the touch screen has to read the current 
setpoint without having the read the summer/winter setpoints.

Different setpoint state for each mode: The function is enabled if the touch screen has to read 
the summer/winter setpoints of the various HVAC operating modes.

*10 

4 pipe system

2 pipe system

4 pipe system with neutral zone

For these functions, used the same settings assigned to the thermostat parameters under 
“System type”.

*11 

Setpoint range: 

 OFF: the client cannot edit the thermostat setpoint from the touch screen.

 +1 -1 /+5 -5: the client can edit the setpoint within the set range.

 No limit: the client can edit the setpoint as required with no limits.
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*12 

Offset management relative to base setpoint: If there is a shift setpoint datapoint, this function 
controls the setpoint from the touch screen. Select  to enable.

*13 

Fan interlock management: When enabled, this function will enable the fan coil speed only if 
the other two speeds are OFF; it is not possible to have two speeds active at the same time. 
Select  to enable.

*14

Incremental fan management: When enabled, this function allows the incremental fan manage-
ment; use “+” to move between the speeds incrementally, use “A” to force to automatic fan 
speed mode. Select  to enable.

    To add a communication object, the node of the datapoint to be paired with the communication 
object must be selected from the tree representing the system designed with ETS; the selected 
node must then be dragged into the field next to the description of the communication object. 
If the type of datapoint is allowed for the communication object, then the description, datapoint 
code and address will be displayed.

    In the tree representing the system designed with ETS, the datapoints paired with the node of 
the device dragged onto the environment page are proposed for the selection; datapoints paired 
with devices other than the one dragged can in any case be selected.

   To remove the datapoint paired with a communication object, simply use the function button          
provided for each communication object.

The datapoints that can be enabled depend upon the implemented functions, according to 
the thermostat to be configured.

Press Apply to confirm or Cancel to go back to the main screen.

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After adding the device, you can modify both its position and settings. 

Modify position (for Display temperature only): click on the Modify function button  , in the 
bar at the top, and drag it with the mouse pointer. Confirm with the Save changes  function 
button. 

Modify settings: click on the Modify function button  and double click on any element that 
composes the HVAC to be modified. The window will appear with the settings that can be modified. 
The settings can be modified for both the HVAC added in Display temperature mode and for the 
one added in Set temperature mode. 
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To eliminate HVAC elements from the environment page for both Display temperature and  Set 

temperature modes, simply click on the Modify function button  in the bar at the top, select 
any element in the HVAC and press the delete button Del on the PC keyboard.

Configuration parameters for thermostat 20430-19430-14430-02952

To configure the thermostat correctly using the application, the first thing you have to do is link a 
number of fundamental objects to your ETS project. These are:

• Enable-> Summer/Winter

• Shift Setpoint-> Setpoint

• OFF-> Fan Inputs

• Speed V1-> Fan Inputs

• Speed V2-> Fan Inputs

• Speed V3-> Fan Inputs

• Automatic-> Fan Inputs

• Thermostat Mode-> Mode

• Actual Temperature -> Temperature 

• State-> Summer/Winter

• Actual Setpoint-> Setpoint

• Speed V1-> Fan Outputs

• Speed V2-> Fan Outputs

• Speed V3-> Fan Outputs

• Thermostat mode -> Mode State

• 2-tube system valve (cooling/heating)

• 4-tube system valve (heating)

• 4-tube system valve (cooling)

N.B.:
Obviously the valve is added to the project and to the software according to the system 
installed.
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Now we can describe step by step how to configure the fan coil thermostat using the Touchscreen 
Configurator software. 

Having imported the ETS project, we proceed to configure a thermostat. 

First, we create a new environment and drag a thermostat into it.

Another window will open: here we must specify whether we wish to set or view the temperature 
(two ways of viewing the thermostat on the touch screen, as desired).  
Then we drag the thermostat objects into the respective items requested by the application.
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Configuring the KNX weather station, Vimar art. 01546

Drag the device into an environment in the device and then define it as “weather station“:

On the specific screen enter the various weather station datapoints which can be displayed:

The datapoints paired with the measurable values are: 

- Brightness (LUX)

- Twilight (Day or night)

- Wind speed	 (0 - 70 m/s resolution 1m/s)

- Heated rain sensor (On/Off)

- Current temperature (-40/+80°C resolution 0.1°C)

These datapoints do not have to be configured and can be added according to what you need 
to view.
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The atmospheric pressure value is not supplied directly by the weather station 01546; it can how-
ever be paired with a specific datapoint as, to read the pressure value, a non-Vimar KNX device 
may be used. 
The pressure icon will obviously be present only if the function is effectively used.

Example of displayed values read by the weather station on the touchscreen:
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Possible weather conditions that can be displayed on the weather station screen.

The distinction between rain and snow is combined, i.e according to whether it is raining or 
snowing ("Switching output rain" communication object) and the measured air temperature value 
("Measured temperature value" communication object).

The icons paired with the weather status shown on the touchscreen are the following:

=  day without rain

=  night without rain

=  rain with temperature above 2 °C

=  rain with temperature between 0 and 2 °C

=  rain with temperature below 0 °C
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6.1.6 Adding a Single communication object

This window is used for adding and modifying a single communication object on the environment 
page of touchscreen devices.

To add a communication object: 

1. select the environment where you wish to add the communication object; 

2. click on the Modify function button  on the bar at the top;

3.	from the section on the right showing the tree structure of the system designed with ETS, select 
the node corresponding to the communication object you wish to add: do not select the control 
devices (eg buttons), but rather the actuators.

4. use your mouse to drag the selected communication object onto the central environment page 
representing the touchscreen display; 

5. for Boolean type communication objects only, a window will open allowing you to choose the 
type of device; select Boolean device type to add the selected node as a single communication 
object. Otherwise, select the Relay device type to add the selected node as a relay command.
Press the OK function button to confirm.
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6. enter and if necessary modify the required information in the data management window for the 
communication object; the data management window varies according to the type of communica-
tion object selected.

The following types of communication objects can be managed:
-  Boolean
-  3-Bit Controlled
-  Boolean subtypes
-  8-Bit Signed/Unsigned, 2-Octet Signed/Unsigned/Float, 4-Octet Signed/Unsigned/Float 
-  Scene Control.
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The window manages the following information:

•	 Description: description of the device on the environment page; the description of the dragged 
node is shown; the proposed description can however be modified. 

•	 Image: image with which the communication object is represented on the environment page; 

the image can be selected using the    and   function buttons or, for a wider view, the 

 button; (only for the communication objects with type other than "8-Bit Signed/Unsigned, 
2-Octet Signed/Unsigned/Float, 4-Octet Signed/Unsigned/Float").
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•	 Type: type of communication object (datapoint) which can be selected from a specific list;

•	 Group address: address of the dragged communication object; this cannot be modified.

Only for the communication objects with type 8-Bit Signed/Unsigned, 2-Octet Signed/Unsigned/
Float, 4-Octet Signed/Unsigned/Float,the following information is managed: 

•	 Unit of measurement: unit of measurement; this can be selected from a list of available values; 

•	 Conversion factor: conversion of value in order to adapt the display to the particular/usual case 
of use; it can be selected from a list of available values; 

•	 Scaling: scaling which can be selected from a list of available values; 

•	 Number of decimals: number of decimal digits to be displayed. 

The following information is provided only for communication objects of the Scenario type:

•	 Number of scenario: number of the scenario which can be selected from a list. 

An icon can be displayed that simply calls up the scenario or an icon that, when tapped, calls up 
the scenario, when pressed for approximately 2 s, sends a save-scenario message over the bus 
and when pressed a second time sends a subsequent end saving message; this function is useful 
for modifying a scenario created previously.   
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Press Apply to confirm or Cancel to go back to the main screen.

7.	confirm the set configuration via the Save changes function button  in the top toolbar.

After inserting the communication object, you can modify both its position and the 
settings. 

Modify position: click on the Modify function button  , in the bar at the top, and drag it with 
the mouse pointer. Confirm with the Save changes function button  . 

Modify settings: click on the Modify function button  and double click on the button that 
corresponds to the communication object to be modified. The window will appear with the settings 
that can be modified. 

To delete the communication object from the environment page, just click on the Modify function 
button  in the bar at the top, select it with the mouse and press the Del key on the PC 

keyboard.
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6.2 Selecting the default page
The default page is the screen of the touchscreen which is displayed when the touchscreen returns to 
energy savings/screensaver mode. 

To define the default page: 

1.   select the page to set as the default (in this example we have inserted the Main Menu screen);

2.	 click on the Modify function button  ; 

3.	� click on the Set default button    in the toolbar at the bottom;

4.  confirm with the Save changes button  in the toolbar at the top.
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7. Help

The application provides access to online help via the menu Help ► Online Help of the Touchscreen 
Configurator software or by tapping on F1 in the main windows. 

This is contextual help, which means that it displays the text relating to the window where it was called up. 
By selecting the menu Help ► Online Help, help is activated for the window that is on top of all the active 
ones in the application.

Help
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